
设定手册

IP 解码盒

软件版本 7.0

重要事项
本产品适合用于工业用途。
请在使用前仔细阅读（从网站下载的）本设定手册和用户手册，以正
确使用显示器。请保留本手册，以备将来参考。

• 可以从我们的网页查看最新的产品信息，包括设定手册。
www.eizoglobal.com

https://www.eizoglobal.com
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为配合在销售目标区域使用，本产品已经过专门调整。
如在此区域之外的地方进行操作，那么产品的性能可能会不同于规格中所述的性能。

未经EIZO Corporation事先书面许可，不得以任何形式或以任何方式（电子、机械
或其它方式）复制本手册的任何部分、或者将其存放到检索系统中或进行发送。
EIZO Corporation没有义务为任何已提交的材料或信息保密，除非已经依照EIZO
Corporation收到的所述信息进行了事先商议。尽管本公司已经尽最大努力确保本手
册提供最新信息，但是请注意，EIZO产品规格仍会进行变更，恕不另行通知。
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关于本产品

关于本产品的使用
• 该设备将图像从网络摄像机输出到通过 HDMI® 线缆连接的显示器。如果将本产

品用于以下几种需要极高可靠性和安全性的应用场景，则应采取相应措施，确保
使用本产品时的安全性。

– 运输设备（船舶、飞机、火车和汽车）

– 安全装置（灾难预防系统、安全控制系统等）

– 直接影响生命安全的设备（生命支持系统、手术室使用的医疗设备或器材等）

– 核能控制设备（核能控制系统、核设施安全控制系统等）

– 主要系统通信设备（运输系统、空中交通控制系统等的操作控制系统）

• 为配合在销售目标区域使用，本产品已经过专门调整。如果产品使用地并非销售
目标区域，则本产品的工作性能可能与规格说明不符。

• 本产品担保仅在此《手册》中所描述的用途范围之内有效。

• 本文档中概述的规格仅在使用 EIZO 指定的 AC 适配器和信号线时适用。

• 本产品只能与我们制造或指定的选配产品配合使用。

关于安装
• 如果您将本产品放置于涂漆桌面上，可能会有油漆因底座的橡胶材质而粘在其底

部。 使用前检查桌面。

• 将此产品带入低温房间、温度突然上升或将此产品从低温房间移到温暖房间时，
此产品的表面或内部可能会结露。此种情况下，请勿开启产品。等待直到结露消
失，否则可能会损坏产品。

• 请将本产品水平放置在稳定的表面（例如办公桌）上，平坦的一面朝下。
通过使用专用的安装支架（单独出售），本产品可以安装在显示器上使用。安装
支架可以在EIZO网站上购买。www.eizoglobal.com
有关使用安装支架时的安装方向，请参照安装支架使用说明手册。

https://www.eizoglobal.com
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网络安全警告和责任
• 请采取以下措施来保护产品和信息资产免受网络攻击。

– 防止第三方在未经授权的情况下对产品进行物理访问。

– 管理密码，以防泄露。

– 在安全的网络上使用本产品，例如与互联网隔离的网络、防火墙内的网络或
VPN（虚拟专用网络）。

• 如果EIZO Corporation或其分销商要求更新软件，请立即更新。请使用EIZO
Corporation或其分销商提供的软件更新数据。

• 可以将本产品配置为启动时自动登录，无需输入用户名和密码。设定自动登录
时，管理员有责任采取措施防止未经授权的访问。

• 本产品加密并保存用户名和密码等个人信息，并将其用于设备身份验证。为了防
止信息泄露，请确保采用正确的处置方法，例如在丢弃产品时擦除或销毁数据。

• 该产品配备了各种安全功能，可防止恶意访问。可适当使用这些功能来提高产品
的安全性。

– USB 锁定功能

– 遥控锁定功能

– HTTPS功能

– Web 界面禁用功能

– IP 地址过滤器功能

– IEEE 802.1X 功能
有关各功能的详细信息，请参照用户手册。
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清洁
• 建议定期清洁，以保持产品外观清洁同时延长使用寿命。

• 请使用少量水或蘸有在水中稀释的温和洗涤剂的软布轻轻擦拭本产品上的所有污
垢。

注意

• 切勿使用任何可能会损伤产品的稀释剂、苯、蜡或研磨型清洁剂。

• 使用酒精或其他化学制剂进行消毒可能会导致出现裂痕、光泽度发生变化、变色、褪色
或显示图像质量下降。使用产品时请注意以下几点。

– 请勿使化学制剂直接接触产品。

– 请勿使用浸过化学溶液的湿布，因为它们可能含有大量液体。

– 请勿让化学制剂进入缝隙或产品内部。

• 有关清洁和消毒的更多信息，请参照我们的网页。
查看方法：访问www.eizoglobal.com，然后在网页搜索框中键入“disinfect”进行搜
索

免责声明
• 若因使用本产品或本产品故障或任何其他相关问题而产生任何直接或间接损失

（包括但不限于预期利润损失），EIZO 概不负责。

– 客户滥用或疏忽

– 客户私自拆卸、维修或修改

– 由于任何原因（包括产品故障或缺陷）无法显示图像

– 与第三方设备或器械组合

– 由于任何原因发生侵犯隐私或与客户监控图像相关的其他问题

– 由于任何原因丢失注册或记录的信息

• 本产品可以显示由摄像机监控的图像，但本产品本身并不能防止犯罪等行为。

https://www.eizoglobal.com
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1 简介
本文档说明了在显示器上显示摄像机（网络摄像机）图像所需的设定。

1.1 包装内容
请检查包装盒中是否包含下列所有物品。如果缺少物品或物品损坏，请与另行列出的
您当地的经销商或EIZO代表联系。

注

• 建议保留好包装盒和包装材料，以便将来移动或搬运本产品时使用。

• DX0231-IP（产品主机）

• HDMI线缆（HDMI - HDMI，0.5 m）：HH050HS x 1

• PCSK-04 / PCSK-03 / PCSK-03R 安装螺丝（M3 x 6）x 2
在连接小型终端安装适配器（PCSK-04/PCSK-03/PCSK-03R）时使用。

• 设定手册（本文档）

• 预防措施
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1.2 控制和功能
1.2.1 正面

3 4 521

1. 遥控器接收器单元的连
接端口

如果由于安装位置原因无法使用遥控器接收器单元，请使用遥
控器接收器电缆连接接收器单元。

使用遥控器接收器单元时，主机上的遥控器接收器被禁用。

2. “重置” 按钮 长按 10 秒钟可初始化以下信息。

• 摄像机信息

• USB 锁

• 用户账户设定

3. 遥控器接收器 接收来自遥控器的信号。有关接收器范围的详细信息，请参照
用户手册。

4. 按钮 开关电源。

5. 电源指示灯 显示产品的运行状态。

蓝色：正常工作模式

蓝色闪烁：启动

红色：电源关闭

熄灭：主电源关闭
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1.2.2 背面

3 4 521

1. 立体声微型插孔 该端口发出产品主机的蜂鸣音或来自网络摄像机的音频。连接
市售立体声微型插孔电缆。

2. HDMI 1 / HDMI 2 HDMI 信号输出连接器。连接到支持 HDMI® 信号的显示
器。

3. 下游 USB 端口 连接 USB 鼠标、USB 键盘或操纵杆。

4. LAN 端口 连接网线。连接到支持 PoE+ 的网络交换机时提供电源。

a b
a)
主动式 LED

关闭：无数据通信

橙色闪烁：数据通信正在进行中

b)
链接 LED

关闭：网络连接未建立

绿色：网络连接已建立

5. DC 输入 连接 AC 适配器（单独出售）。
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1.3 系统配置
本产品的使用需要连接网络。

摄像机

显示器

HDMI 线缆

USB 鼠标

操纵杆USB 键盘遥控器

网络线缆

本产品

网络交换机

计算机

1.3.1 摄像机（网络摄像机）
符合 ONVIF® Profile S 的摄像机、Axis 摄像机或 Panasonic/i-PRO 摄像机。

注意

摄像机兼容性

• 除了显示视频外，本产品还支持摄像机的 PTZ 控制和设定更改。但是，由于未提供所需
API 等原因，并非所有功能都可用。对于本产品无法提供或无法按预期运行的功能，请
直接在摄像机上进行操作。

• 如果您需要通过本产品控制摄像机的 PTZ 设定，请参照经过验证的摄像机的兼容性信
息。
www.eizoglobal.com/support/db/products/model/DX0231-IP/

ONVIF 是 ONVIF Inc. 的商标。

https://www.eizoglobal.com/support/db/products/model/DX0231-IP/
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1.3.2 网络交换机
兼容 1000BASE-T/100BASE-TX 的网络交换机

本产品支持 PoE+。使用网线供电时，请使用兼容 PoE+ 的网络交换机。

注

• 使用 AC 适配器（单独出售）时，网络交换机无需支持 PoE+（使用网线为摄像机供电
时，必须支持 PoE）。

1.3.3 网络线缆
5e 类或更高等级的直线电缆

1.3.4 USB 鼠标
用于控制直播画面和设定画面。

注意

• 使用遥控器只能控制实时图像屏幕。
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1.3.5 计算机
用于设定本产品和摄像机。配置完成后，可以将其从网络中删除。

仅当您使用计算机时，以下设定才可用。

• 在摄像机名称中输入除字母数字字符和符号以外的字符

• 更新软件

• 注册许可证

• 保存/加载系统信息

如果您的计算机没有 LAN 端口，请考虑使用 USB LAN 适配器。

注

IP 地址

• 因为一个 IP 地址对应一个网络地址，所以每个设备都必须设定一个唯一的 IP 地址（请
参照2.8 设定IP地址 [} 27]）。如果设定了与另一台设备重叠的 IP 地址，则通信将无
法正常进行。

IP 地址：192.168.0.10 
子网掩码：255.255.255.0 
网关：空白

摄像机

IP 地址：192.168.0.11 
子网掩码：255.255.255.0 
网关：空白

IP 地址：192.168.0.2 
子网掩码：255.255.255.0 
网关：空白

显示器

本产品

IP 地址：192.168.0.150 
子网掩码：255.255.255.0
网关：空白

IP 地址：192.168.0.151 
子网掩码：255.255.255.0
网关：空白

计算机

• 如果您的网络环境不包含网关（默认网关），则无需设定“Gateway”地址。

• 该产品的默认IP地址是“192.168.0.150”。安装多个设备时，请设定唯一的 IP 地址
（请参照4.6 检查是否有重复的 IP 地址 [} 48]）。

1.3.6 视频显示器
使用 HDMI 线缆连接到产品以显示摄像相机图像。使用支持 HDMI 且可以显示本产
品输出分辨率的显示器。连接两台显示器时，请准备具有相同分辨率的显示器。有关
输出分辨率的信息，请参照用户手册。
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2 设定

2.1 准备事项
准备 USB 鼠标和计算机。

如果您的工作地点没有互联网连接，请提前在计算机上保存以下文件。

文件 获取位置

一套用户手册

• 设定手册（本文档）

• 用户手册

请从 EIZO 网页下载必要的文件。

www.eizoglobal.com/support/db/products/model/
DX0231-IP/

最新版本的系统软件

许可证文件 购买许可证即可获得其他功能。有关功能的详细信息，请参照
用户手册。有关购买许可证的详细信息，请联系您的经销商或
当地的 EIZO 代表。

2.2 设定摄像头
要使用本产品显示摄像机图像，必须事先设定摄像机。

请参阅摄像机的用户手册并进行以下设定。

2.2.1 用户名和密码
为具有管理权限的用户设定密码，密码使用字母数字字符和符号，最多 32 个字符。

2.2.2 日期和时间
选择时区并设定正确的日期和时间。

2.2.3 IP Address
设定不与其他设备重叠的 IP 地址。

https://www.eizoglobal.com/support/db/products/model/DX0231-IP/
https://www.eizoglobal.com/support/db/products/model/DX0231-IP/
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2.2.4 Stream
设定流以匹配本产品的显示性能。

• 检查流是否已启用。

• 使用“Panasonic/i-PRO”协议时，它默认连接到流 2。

注

摄像机流

通常，摄像机支持多个流，可以同时传输不同分辨率和帧速率的视频。

录像机

流 1

压缩格式：H.265 
分辨率：1920 x 1080 
帧速率：30 Hz 
比特率：4096 kbps

流 2

压缩格式：H.264 
分辨率：1280 x 720 
帧速率：20 Hz 
比特率：4096 kbps

本产品

显示器

• 通过将用于录制的流 1 和用于观看实时图像的流 2 分开，您可以防止直播设定的更改影
响其他设备。

• 使用“Panasonic/i-PRO”协议注册摄像机时，它默认连接到流 2。

• 可以通过手动注册来更改要连接的流（请参照3.4 手动注册摄像机 [} 33]）。
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视频压缩格式

根据用于摄像机注册的“Protocol”选择视频压缩格式。

• “ONVIF”
H.264 或 MJPEG（当“Media Type”为“Media1”时），或 H.265 或 H.264
（当“Media Type”为“Media2”*1时）。

• “AXIS®”
H.265 或 H.264

• “Panasonic/i-PRO”
H.265 或 H.264

*1 摄像机必须符合 ONVIF Profile S 和 ONVIF Profile T。

注

• 有关 H.265 的最新运行状态，请参照 EIZO 网站上的摄像机兼容性信息。

Bit Rate

将值设定为 8192 kbps 或更低。（推荐 4096 kbps）

Resolution/Frame Rate

根据要同时显示在实时图像屏幕上的摄像机数量设定“Resolution”和“Frame
Rate”。
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H.265/H.264（当“Bit Rate”设定为“4096 kbps”时）

视频显示器分辨率为 1920 x 1080，60 Hz

1 Screen Layout 3840 x 2160 / 30 fps，1920 x 1080 / 60 fps，1280 x 720 /
60 fps

4 Screens Layout 3840 x 2160 / 20 fps，1920 x 1080 / 60 fps，1280 x 720 /
60 fps

9 Screens Layout 1920 x 1080 / 30 fps，1280 x 720 / 50 fps，640 x 480 / 60
fps

12 Screens Layout 1920 x 1080 / 20 fps，1280 x 720 / 40 fps，640 x 480 / 60
fps

16 Screens Layout 1920 x 1080 / 20 fps，1280 x 720 / 40 fps，640 x 480 / 60
fps

32 Screens Layout 1280 x 720 / 15 fps，640 x 480 / 30 fps

视频显示器的分辨率为 3840 x 2160，60 Hz

1 Screen Layout 3840 x 2160 / 30 fps，1920 x 1080 / 30 fps，1280 x 720 /
30 fps

4 Screens Layout 3840 x 2160 / 20 fps，1920 x 1080 / 30 fps，1280 x 720 /
30 fps

9 Screens Layout 1920 x 1080 / 25 fps，1280 x 720 / 30 fps，640 x 480 / 30
fps

12 Screens Layout 1920 x 1080 / 20 fps，1280 x 720 / 25 fps，640 x 480 / 30
fps

16 Screens Layout 1920 x 1080 / 20 fps，1280 x 720 / 25 fps，640 x 480 / 30
fps

32 Screens Layout 1280 x 720 / 15 fps，640 x 480 / 20 fps

MJPEG

640 x 480 / 30 fps

注意

• 以上值仅供参考。

• 如果视频流超过本产品的显示能力，则摄像机视频的帧速率将被强制降低。降低分辨率
和/或比特率。
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2.3 安装
本产品可以放置在稳定的底座上，例如办公桌，也可以使用特殊的安装硬件进行安装
（可选，单独出售）。

为了保护产品和信息资产免受网络攻击，用户有责任采取措施防止第三方未经授权对
产品进行物理访问。

产品可以按以下方位放置：

2.4 连接设备
注

• 本产品支持 PoE+。如果网络交换机支持 PoE+，则通过网络交换机提供电源来运行，
因此无需连接 AC 适配器。

• 如果您的网络交换机不支持 PoE+，请使用 AC 适配器（单独出售）。请按照以下步骤
完成连接。

1. 将电源线插头插入 AC 适配器。

2. 将 AC 适配器的输出端口与产品的 DC 输入端口连接（将其完全牢固地插入到位）。

3. 连接电源插头至电源插座。

• 在连接支持 PoE+ 兼容性功能的网络交换机时，如果使用 AC 适配器，则电源由 AC 适
配器提供。

1. 使用网络电缆将本产品和摄像机连接到网络交换机。
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2. 使用 HDMI 线缆连接本产品和视频显示器。

HDMI 线缆 HH050HS
（随附）

3. 将 USB 鼠标连接到下游 USB 端口。

注

• 连接到具有 USB 集线器功能的设备可实现多个 USB 设备同时使用。

2.5 打开电源并显示实时图像屏幕
1. 按下产品正面的电源键（ ）。

准备开始时，电源指示灯呈蓝色闪烁。设备启动大约需要 1 分钟。

启动时，电源指示灯变为蓝色并显示屏幕。如果初始用户注册完成，则会显示实
时屏幕。
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2. 首次启动本产品时，将显示初始用户注册屏幕。设定每个项目。
– “Language”（Language [} 22]）
– “Keyboard Layout”（Keyboard Layout [} 22]）
– “User Level”

首次注册时无法选择用户级别（固定为“ADMIN”）。
– “Username”（Username [} 23]）
– “Password”（Password [} 23]）
– “Confirm Password”

请重新输入相同的密码进行确认。

注

• 也可以从 Web 控制台执行初始用户注册（请参照使用 Web 控制台时 [} 24]）。

3. 单击“Apply”。
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4. 在确认对话框中单击“OK”。
重新启动后，将显示实时屏幕。

视频显示区域
・如果未注册摄像机，将显示 “Not Registered”。
・如果发生错误，将显示错误代码。

摄像机操作菜单

显示菜单 系统菜单

注

• 要关闭电源，请按产品正面的电源键（ ）。

• 您也可以使用遥控器上的电源键（ ）打开/关闭电源。

Language

设置：“日本語”/“English”/“Deutsch”

选择语言。

Keyboard Layout

设置：“Japanese”/“English(US)”/“English(UK)”/“German”

选择键盘布局。
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Username

输入用户名。设定用户名，使其满足以下条件。

• 最少 1 个字符，最多 16 个字符

• 仅限字母数字字符

• 至少 1 个数字

• 不包含字符 # &: "<>\

无法设定以下用户名。

• “.” / “..” / “auto-login”

Password

输入密码。设定第三方难以猜到的密码。

• 8 至 16 个字符

• 至少一个大写和小写英文字母

• 至少一个数字

• 不包含字符\

2.6 显示设定屏幕
可以使用显示器控制台（显示器上显示的屏幕）或 Web 控制台（浏览器上显示的屏
幕）来操作设定屏幕。

要显示设定屏幕，必须以用户级别为“ADMIN”的用户身份登录。

2.6.1 使用显示器控制台时
使用鼠标执行操作。无法使用遥控器操作设定屏幕。

单击需要输入字符的项目将显示软件键盘。

1. 在实时图像屏幕上，单击登录图标 （ ）。

2. 输入用户名和密码。

3. 单击“Login”。
然后可以选择设定图标（ ）。

4. 单击设定图标（ ）。
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2.6.2 使用 Web 控制台时
操作在连接至网络的计算机上执行。

注

• 有关在计算机上配置网络设定的信息，请参照4.7 检查计算机的 IP 地址 [} 48]。

• 建议使用 Microsoft Edge 版本 79 或更高版本。

• 由于通过 HTTP 进行的通信未加密，因此存在数据可能被第三方截获的风险。为确保安
全通信，建议使用 HTTPS。

• 在首次启动期间通过 https:// 进行访问时，由于使用了自签名证书，您的浏览器中可能
会出现警告。这是正常现象。如果出现警告，请单击“高级设定”或“更多信息”，然
后选择 “访问此站点（不安全）”。登录后，注册“CA-Signed Certificate”，警告将
不再显示。

1. 启动 Web 浏览器。

2. 输入访问产品的地址。
地址：http://<IP address of product>/ 或 https://<IP address of
product>/
在默认设定中，可以从http://192.168.0.150/ 或 https://192.168.0.150/ 显
示。
如果无法显示 Web 控制台，请参照4.4 其他问题 [} 46]。

3. 输入用户名和密码。
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4. 单击“OK”。
出现设定屏幕。

注

• 如果您无法登录，请尝试使用以下地址。
http://<IP address of product>/index.html或https://<IP address of product>/
index.html

当在显示器控制台上显示时，将显示“Logout”而不是“Return”。
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2.7 设定日期和时间
在系统中设定正确的日期和时间将防止与摄像机的通信出现问题。

1. 选择“System”>“Date and Time”。

2. 设定每个项目。
– “Current Time”（Current Time [} 26]）
– “Date/Time Display Settings”（Date/Time Display Settings [} 26]）
– “Time Zone Settings”（Time Zone Settings [} 26]）
– “Clock Settings”（Clock Settings [} 26]）

3. 单击“Apply”。

2.7.1 Current Time

Current Time

显示产品的当前日期和时间。

Current Time of PC

它在使用 Web 控制台时显示。

选择“Sync with PC”时，本产品将设定为计算机的当前日期和时间。

2.7.2 Date/Time Display Settings

Date Format

设置：“yyyy/mm/dd”/“Mmm/dd/yyyy”/“dd/Mmm/yyyy”/“mm/dd/
yyyy”/“dd/mm/yyyy”

选择日期显示格式。

Time Format

设置：“24h”/“12h”

选择时间显示格式。

2.7.3 Time Zone Settings

Time Zone

选择时区。

2.7.4 Clock Settings

Date and Time

设定当前时间
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2.8 设定IP地址
1. 选择“System”>“Network”。

2. 设定每个项目。
– “IP Setting Method”（IP Setting Method [} 27]）
– “IP Address”（IP Address [} 27]）
– “Subnet Mask”（Subnet Mask [} 27]）
– “Gateway”（Gateway [} 27]）

3. 单击“Apply”。

2.8.1 Network

IP Setting Method

设置：“DHCP”/“Manual”

选择 IP 地址设定方法。

注

• 如果您有 DHCP 服务器，请选择“DHCP”，IP 地址将自动设定。由于无法在 Web 控
制台上查看设定的 IP 地址，因此请在显示器控制台上查看。

IP Address

设置：“0.0.0.1”至“255.255.255.254”

设定不与其他设备重叠的 IP 地址。

注

• 默认IP地址为“192.168.0.150”。安装本产品的多个单元时，请设定唯一的 IP 地址。
有关如何检查重复项的信息，请参照4.6 检查是否有重复的 IP 地址 [} 48]。

Subnet Mask

设置：“0.0.0.1”至“255.255.255.254”

设定子网掩码。

Gateway

设置：“0.0.0.1”至“255.255.255.254”

显示默认网关。

如果您的网络环境没有网关，则无需设定 “Gateway”。保留默认设定或留空。
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2.9 配置语言
1. 选择“System”>“Language”。

2. 设定每个项目。
– “Language”（Language [} 28]）
– “Keyboard Layout”（Keyboard Layout [} 28]）

3. 单击“Apply”。

Language

设置：“日本語”/“English”/“Deutsch”

选择语言。

Keyboard Layout

设置：“Japanese”/“English(US)”/“English(UK)”/“German”

选择键盘布局。
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2.10 使用 Auto Discovery 注册摄像机
可以自动检测和注册连接到网络的摄像机。

注意

• 以下摄像机和视频编码器必须手动注册（请参照3.4 手动注册摄像机 [} 33]）。

– 无法自动发现的摄像机
- 无法自动发现不同子网上的摄像机。
- 某些摄像机可以设定为拒绝自动发现，或仅允许在摄像机开启后的特定时间段内自
动发现。

– 支持多视频流的鱼眼/全景摄像机

– 连接多个摄像机的视频编码器

1. 选择“Camera Registration”。

2. 单击“Automatic Camera Detection”。

3. 设定每个项目。
– “Protocol”（Protocol [} 29]）
– “User Name”（User Name [} 30]）
– “Password”（Password [} 30]）

4. 单击“OK”。
显示检测到的摄像机列表。
摄像机能否自动检测取决于摄像机和网络。未出现在列表中的摄像机必须手动注
册。

5. 选中要注册的摄像机，然后选择“Add”。

6. 单击“Apply”。

7. 在确认对话框中单击“OK”。
摄像机图像显示在实时屏幕上。
如果显示通信错误，请参照4.2 摄像机注册问题 [} 43]。
如果视频显示不正确，请参照4.3 视频问题 [} 43]。

Protocol

选择摄像机的控制协议。

• “ONVIF”*1

兼容 ONVIF Profile S 的摄像机

• “AXIS”
Axis摄像机（VAPIX®）

• “Panasonic/i-PRO”
Panasonic/i-Pro 摄像机

*1 当“Protocol”设定为“ONVIF”时，“Media Type”将为“Media1”。
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User Name

输入摄像机的用户名。需要具有管理权限的用户。

Password

输入摄像机的密码。

2.11 准备遥控器
注

• 遥控器是单独出售的可选配件。

如何安装和取出电池
1. 向上转动遥控器底部并沿箭头方向滑动以取下电池盖。

2. 按照遥控器上标注的“+（正极）”和“-（负极）”插入电池（AAA 规格，2
节）。

3. 重新盖上电池盖。

*要取出电池，请按照步骤 2 将其取出。
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3 其他设定

3.1 更新软件
使用 Web 控制台执行操作。

您可以执行软件版本升级。请提前从 EIZO 网站（www.eizoglobal.com）下载版本
更新文件。为了系统的稳定运行，建议使用最新的软件。无法恢复到旧版本。

1. 选择“System”>“Maintenance”。

2. 单击“Software Update”>“File”>“Browse”。

3. 选择软件文件（扩展名：duraup4）。

4. 单击“Start”。

5. 在确认对话框中单击“OK”。
过程开始。
在处理过程中，电源指示灯呈红色闪烁。请勿关闭电源。更新软件大约需要五分
钟。

3.2 注册许可证
使用 Web 控制台执行操作。

1. 选择“System”>“Maintenance”。

2. 单击“License Activation”>“Extensions”>“Activate”。

3. 单击“Browse”并选择许可证文件（扩展名：duralic）。

4. 单击“OK”。
过程开始。
关闭浏览器并等待 2 分钟，然后再次访问。

注意

• 选择“Deactivate”将删除所有其他注册的许可证。

https://www.eizoglobal.com/
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3.3 保存设定数据并将其加载到其他产品
使用 Web 控制台执行操作。

您可以保存已完成设定的产品的设定数据，并将它们加载到网络上的其他产品中。这
样就无需一次设定一个单元。

将从中复制设定数据的产品

将设定数据
复制到的产品 设定数据文件

加载设定数据

保存设定数据

注意

• 提前为每个产品设定唯一的 IP 地址。如果 IP 地址重复，则无法显示 Web 控制台。

1. 显示要从中复制设定数据的产品的 Web 控制台。
地址：http://<要从中复制设定数据的产品的 IP 地址>/

2. 选择“System”>“Maintenance”。

3. 单击“Settings Data Migration”>“Settings Data”>“Save”。

4. 在“Settings Data Migration”对话框中，在“Password”中输入密码为文件
设定密码。

5. 单击“OK”。

6. 指定保存文件的位置。
设定数据文件已保存。

7. 显示要将设定数据复制到的产品的 Web 控制台。
地址：http://<要将设定数据复制到的产品的 IP 地址>/

8. 选择“System”>“Maintenance”。

9. 点击“Settings Data Migration”>“Settings Data”>“Load”。

10. 选择设定数据文件并输入您设定的密码。
不要选中“Include network settings”。

11. 单击“OK”。
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12. 在确认对话框中单击“OK”。
过程开始。
关闭浏览器并等待 2 分钟，然后再次访问。

3.4 手动注册摄像机
以下摄像机和视频编码器必须手动注册。

• 无法自动检测到的摄像机

• 具有多个不同图像流的鱼眼/全景摄像机

– 使用相同的 IP 地址注册多个鱼眼/全景摄像机，并指定要显示的视频流。

• 连接多个摄像机的视频编码器

– 使用相同的 IP 地址注册多个视频编码器，并指定要显示的视频流。对于支持
多通道的 Panasonic/i-PRO 视频编码器，请在“Channel”中指定要显示的
摄像机。

注意

• 即使手动注册摄像机，摄像机也必须连接到网络。

1. 选择“Camera Registration”。

2. 选中要注册的位置编号，然后单击编辑图标（ ）。

3. 设定每个项目。
显示的项目因协议而异。首先选择“Protocol”。
– 普通项目（普通项目 [} 34]）
– “ONVIF”（ONVIF [} 35]）
– “AXIS”（AXIS [} 36]）
– “Panasonic/i-PRO”（Panasonic/i-PRO [} 37]）
– “EIZO Streaming Gateway”（EIZO Streaming Gateway [} 38]）
– “DirectUri”（DirectUri [} 40]）
– “SRT”（SRT [} 41]）
– “Qognify”（Qognify [} 41]）

4. 单击“OK”。
摄像机图像显示在实时屏幕上。
如果显示通信错误，请参照4.2 摄像机注册问题 [} 43]。
如果视频显示不正确，请参照4.3 视频问题 [} 43]。
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3.4.1 普通项目

Protocol

设置：“ONVIF”/“AXIS”/“Panasonic/i-PRO”/“EIZO Streaming
Gateway”/“DirectUri”/“SRT”*1/“Qognify”*1

*1 当为本产品注册相应的扩展功能许可证时，可以选择此选项。

选择摄像机的控制协议。

• “ONVIF”
兼容 ONVIF Profile S 的摄像机

• “AXIS”
Axis摄像机（VAPIX）

• “Panasonic/i-PRO”
Panasonic/i-Pro 摄像机

• “EIZO Streaming Gateway”
选择是否要连接到启用了流媒体网关功能的产品。

• “DirectUri”
当连接至 RTSP 流 URI（以 rtsp:// 开头的 URI）或 RTP 流 URI（以 rtp:// 开头
的 URI）时选择。

• “SRT”
选择连接到 SRT 流 URI。

• “Qognify”
与 Qognify VMS 关联时选择此选项。

Camera Name

设置：任何字符（最多 100 个字符）

输入摄像机名称。要输入字母数字字符和符号以外的字符，请使用 Web 控制台。

输入“IP Address”、“Port”、“Username”、“Password”，然后单击
“Obtain Camera Name”从摄像机获取摄像机名称。

IP Address

设置：“0.0.0.1”至“255.255.255.254”

输入摄像机的 IP 地址。

单击“Ping”对摄像机执行连接测试。
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Port

设置：“1”至“65535”

输入摄像机的端口号。

注

• 当“Protocol”是“ONVIF”、“AXIS”、“Panasonic/i-PRO”时，典型的端口号为
“80”（如果启用 SSL 则为“443”）；当“Protocol”是“DirectUri”且“URI”是
RTSP 流URI时，典型的端口号为“554”。

• 如果“Protocol”设定为“EIZO Streaming Gateway”，则输入流媒体网关 Web 服
务器的访问端口（默认值：“80”，或者，如果启用 SSL，则为“443”）。

• 如果“Protocol”设定为“Qognify”，则输入 Qognify VMS 的服务器访问端口（默
认值：62000）。

3.4.2 ONVIF

SSL

配置安全设定。

摄像机必须设定服务器证书。

由于通过 HTTP 进行的通信未加密，因此存在数据可能被第三方截获的风险。为确
保安全通信，建议使用 SSL（HTTPS）。

Certificate Validation

在 SSL 通信期间执行证书验证。

摄像机的根证书必须在“Certificate”>“Root Certificate”中注册。

Username

设置：字母数字字符和符号（最多 32 个字符）

输入摄像机的用户名。需要具有管理权限的用户。

Password

设置：字母数字字符和符号（最多 32 个字符）

输入摄像机的密码。
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Media Type

设置：“Media1”/“Media2”

选择媒体类型。

• “Media1”（默认设定）
选择连接到 H.264 和 MJPEG 流。

• “Media2”
选择连接到 H.265 和 H.264 流。摄像机必须符合 ONVIF Profile S 和 ONVIF
Profile T。

Media Profile

设置：取决于摄像机

通过选择媒体配置文件来指定要连接的流。单击“Obtain Profile”从摄像机获取配
置文件列表。

Transmission Mode

设置：“Unicast”/“Multicast”

选择传输模式

Comm. Method

设置：“RTP over UDP”/“RTP over RTSP”

选择摄像机视频图像的通信方式。

3.4.3 AXIS

SSL

配置安全设定。

摄像机必须设定服务器证书。

由于通过 HTTP 进行的通信未加密，因此存在数据可能被第三方截获的风险。为确
保安全通信，建议使用 SSL（HTTPS）。

Certificate Validation

在 SSL 通信期间执行证书验证。

摄像机的根证书必须在“Certificate”>“Root Certificate”中注册。

Username

设置：字母数字字符和符号（最多 32 个字符）

输入摄像机的用户名。需要具有管理权限的用户。



其他设定 | 3

37

Password

设置：字母数字字符和符号（最多 32 个字符）

输入摄像机的密码。

Video Stream

设置：取决于摄像机

选择流的查看区域。单击“Obtain Stream”从摄像机获取查看区域列表。

查看区域用于流式传输整个图像的一部分。有关详情，请参照摄像机的《用户手
册》。

Stream Profile

设置：取决于摄像机

通过选择流配置文件来指定要连接的流。单击“Obtain Profile”从摄像机获取配置
文件列表。

如果摄像机上未注册任何配置文件，则本产品会自动将“EIZO_Profile”配置文件注
册到摄像机。

Transmission Mode

设置：“Unicast”/“Multicast”

选择传输模式

Comm. Method

设置：“RTP over UDP”/“RTP over RTSP”

选择摄像机视频图像的通信方式。

3.4.4 Panasonic/i-PRO
无法在本产品上设定单播/多播。更改摄像机上的传输模式。

SSL

配置安全设定。

摄像机必须设定服务器证书。

由于通过 HTTP 进行的通信未加密，因此存在数据可能被第三方截获的风险。为确
保安全通信，建议使用 SSL（HTTPS）。

Certificate Validation

在 SSL 通信期间执行证书验证。

摄像机的根证书必须在“Certificate”>“Root Certificate”中注册。
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Username

设置：字母数字字符和符号（最多 32 个字符）

输入摄像机的用户名。需要具有管理权限的用户。

Password

设置：字母数字字符和符号（最多 32 个字符）

输入摄像机的密码。

Stream

设置：“1”/“2”/“3”/“4”

选择要连接的流。

Channel

设置：“1”/“2”/“3”/“4”

选择流通道。

Comm. Method

设置：“RTP over UDP”/“RTP over RTSP”

选择摄像机视频图像的通信方式。

3.4.5 EIZO Streaming Gateway

SSL

配置安全设定。

摄像机必须设定服务器证书。

由于通过 HTTP 进行的通信未加密，因此存在数据可能被第三方截获的风险。为确
保安全通信，建议使用 SSL（HTTPS）。

Certificate Validation

在 SSL 通信期间执行证书验证。

摄像机的根证书必须在“Certificate”>“Root Certificate”中注册。

Username

设置：字母数字字符和符号（最多 32 个字符）

输入摄像机的用户名。需要具有管理权限的用户。

Password

设置：字母数字字符和符号（最多 32 个字符）

输入摄像机的密码。
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Stream List

指定要连接的流。单击“Obtain Stream List”按钮从发射器获取流列表。

如果将源的“Streaming Gateway”>“Streaming settings”>“Protocol”设置
为“RTP”，则无法选择该流。

RTSP Username

设置：字母数字字符和符号（最多 79 个字符）

RTSP 用户名是自动设定的。它也可以更改。

RTSP Password

设置：字母数字字符和符号（最多 79 个字符）

RTSP 密码是自动设定的。它也可以更改。

RTSP Comm. Method

设置：“RTP over RTSP”

选择摄像机视频图像的通信方式。

SRT Latency

设置：“20 ms”至“8000 ms”

设定延迟。

当为本产品注册相应的扩展功能许可证时，可以选择此选项。

SRT Passphrase

设置：字母数字字符和符号（最多 79 个字符）

设定密码。

当为本产品注册相应的扩展功能许可证时，可以选择此选项。
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3.4.6 DirectUri

注

• 要接收具有 RTP 的 MPEG2-TS 流，请在“RTP over RTSP”中选择“Comm.
Method”或“RTP over UDP”。

• 要通过 UDP 接收 MPEG2-TS 流，请检查以下几点。

– 在“Port”中指定接收流的端口号（1024 到 65535），然后在“Comm.
Method”中选择“MPEG2-TS over UDP”。

– 您应提前从发射器设置本产品的流传输设定。

– 对于非多播通信，请将 IP 地址留空。

Username

设置：字母数字字符和符号（最多 32 个字符）

输入摄像机的用户名。需要具有管理权限的用户。

Password

设置：字母数字字符和符号（最多 32 个字符）

输入摄像机的密码。

URI

设置：字母数字字符（最多 1023 个字符）

输入 RTSP 流 URI（以 rtsp://、http:// 或 https:// 开头）或 RTP 流 URI（以 rtp://
开头）。

Transmission Mode

设置：“Unicast”/“Multicast”/“Source-Specific Multicast”

选择传输模式

Comm. Method

设置：“RTP over UDP”/“RTP over RTSP”/“MPEG2-TS over UDP”/
“RTSP over HTTP”/“RTSP over HTTPS”

选择摄像机视频图像的通信方式。
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3.4.7 SRT

Latency

设置：“20 ms”至“8000 ms”

设定延迟。

Passphrase

设置：字母数字字符和符号（最多 79 个字符）

设定密码。

3.4.8 Qognify

Username

设置：字母数字字符和符号（最多 32 个字符）

输入摄像机的用户名。需要具有管理权限的用户。

Password

设置：字母数字字符和符号（最多 32 个字符）

输入摄像机的密码。

Camera List

单击“Obtain Camera Name”检索摄像机名称列表。

Comm. Method

设置：“RTP over RTSP”

选择摄像机视频图像的通信方式。
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4 故障排除

4.1 电源问题
4.1.1 不显示实时图像屏幕

• 电源指示灯未打开

– 电源连接正确吗？连接 AC 适配器或支持 PoE+ 的网络交换机。

– AC 适配器和网络交换机的电源线是否正确连接？

• 电源指示灯为红色

– 按下产品正面的电源键 （ ）。

• 电源指示灯呈红色闪烁

– 已连接到兼容 PoE 的网络交换机，但电源不足。连接到支持 PoE+ 的网络或
AC 适配器（单独出售）。

• 电源指示灯为蓝色

– 检查产品是否已使用 HDMI 线缆正确连接到显示器。连接到 HDMI 1 而不是
HDMI 2。

– 拔出 HDMI 线缆，然后重新连接。

– 检查显示器的输入信号是否已设定为 HDMI。检查显示器设定是否正确。有
关更多详情，请参照显示器的《用户手册》。

4.1.2 停电后，不再显示摄像机图像
• 如果显示错误代码“E**-**”，请参照4.3 视频问题 [} 43]。

• 请求摄像机再次传输流。

– 对于显示器控制台，用鼠标单击设定图标（ ）以显示设定屏幕，然后选择
“Return”返回实时图像屏幕。

– 对于 Web 控制台，选择“Live Image Screen”>“Stream Refresh”
>“Stream Refresh”>“Execute”。

• 电源关闭并重新打开后可能需要重置设定，具体取决于摄像机。检查摄像机设定
是否正确（请参照2.2 设定摄像头 [} 15]）。

4.1.3 突然重启
• 当产品内部温度升高时，本产品可能会反复重启。检查本产品周围的温度。当产

品在狭窄或通风不良的地方使用时，或者在产品上面放置物体时使用时，内部温
度可能会升高。
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4.2 摄像机注册问题
4.2.1 无法自动检测到摄像机

• 摄像机能否自动检测取决于摄像机和网络。未出现在列表中的摄像机必须手动注
册（请参照 3.4 手动注册摄像机 [} 33]）。

4.2.2 在自动发现中单击“Apply”时出现通信错误
自动发现还会检测未设定 IP 地址、用户名或密码的摄像机。要注册，必须正确配置
摄像机。

• 确保您可以连接到摄像机（请参照4.5 使用 Ping 检查摄像机连接 [} 47]）。

• 检查是否为摄像机设定了密码（请参照2.2 设定摄像头 [} 15]）。

• 确保您输入的用户具有管理权限。

• 如果为每个摄像机设定了不同的用户名和密码，请检查显示错误的位置编号，单
击“编辑”（ ），然后重新输入用户名和密码。

4.2.3 在手动注册中单击“Apply”时出现通信错误
• 确保您可以连接到摄像机（请参照4.5 使用 Ping 检查摄像机连接 [} 47]）。

• 检查是否为摄像机设定了密码（请参照2.2 设定摄像头 [} 15]）。

• 确保您输入的用户具有管理权限。

• 确保摄像机的 IP 地址、HTTP 端口（通常为 80）、用户名和密码正确。

• 根据摄像机的不同，有禁用 ONVIF 的设定，以及 ONVIF 的 HTTP 端口、用户
和密码的设定。检查摄像机上是否有与 ONVIF 相关的设定。

• 未经 EIZO 验证的摄像机可能与本产品不兼容。考虑使用“DirectUri”协议注册
摄像机。要将 RTSP 流 URI（以 rtsp:// 开头的 URI）作为 URI 输入，请参照摄
像机的《用户手册》或联系摄像机制造商。通过“DirectUri”协议连接时，可以
显示视频，但无法在摄像机上执行 PTZ 控制和设定更改。

4.3 视频问题
4.3.1 显示错误消息“E**-**”

如果问题未解决，请参照未显示正确的图像 [} 45]。

• E01-**

– 检查摄像机流传输设定是否正确（请参照 2.2 设定摄像头 [} 15]）。

– 由于高负荷，摄像机可能无法正常工作。断开访问摄像机的其他网络设备或降
低摄像机的比特率分辨率。

– 如果摄像机连接到不同的子网，请检查连接子网的路由器上是否允许 TCP 和
UDP 通信。

• E02-**
E02-02
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– 身份验证失败。确保摄像机的用户名和密码正确。
E02-03

– 流传输已停止。如果错误是由摄像机关闭或断开摄像机连接导致的，则错误会
变为 E02-04。

– 如果摄像机连接到不同的子网，请检查连接子网的路由器上是否允许 TCP 和
UDP 通信。

E02-04

– 检查摄像机电源是否已开启。

– 确保您可以连接到摄像机（请参照4.5 使用 Ping 检查摄像机连接 [} 47]）。

– 确保产品或摄像机没有重复的 IP 址（请参照4.6 检查是否有重复的 IP 地址
[} 48]）。
如果产品的 IP 地址重复，则摄像机图像将仅在一台显示器上显示。

具有重复 IP 地址的产品

E02-07

– 如果启用了“Certificate Validation”，请确保证书到期日期和其他信息正确
无误。

E03-**

– 网络带宽可能处于压力之下，或者可能超过本产品的显示性能。降低摄像机的
分辨率和/或比特率（请参照2.2 设定摄像头 [} 15]）。

E04-**

– 可能设定了与本产品不兼容的分辨率。
尝试更改摄像机的分辨率（请参照2.2 设定摄像头 [} 15]）。

E05-**

– 来自摄像机的流数据格式可能与本产品不同。检查摄像机和本产品的设定，然
后重新启动本产品。

E06-**

– 多播设定值可能设定不正确。检查摄像机的设定。
E07-**

– 网络可能未连接，例如网线未连接到本产品。请检查网络连接。
E08-**

– 没有使用摄像机协议所需的许可证。检查许可证。
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4.3.2 移动物体减速或加速
如果问题未解决，请参照未显示正确的图像 [} 45]。

• 流可能包含 B 帧。选择“Live Image Screen”>“Advanced”，将“B frame
decode buffer”变成“Enable”。如果问题没有解决，请取消选中该复选框。
如果B帧是问题的原因，则在摄像机上禁用 B 帧也可以解决问题。

• 可能无法根据摄像机的时间戳输出帧。选择“Live Image Screen”
>“Advanced”，然后将“Sync timestamp”变成“Enable”。如果问题没有
解决，请取消选中该复选框。

4.3.3 未显示正确的图像
图像失真

显示的图像不流畅

显示黑色图像

图像时而正常显示，时而失真

• 选择“Live Image Screen”>“Advanced”，然后将“Network traffic
condition”变成“On”。图像的右上角显示一个表示通信状态的圆圈。如果圆
圈为绿色，表示通信正常。

如果圆圈为黄色或红色，表示无法成功接收数据包。摄像机或网络路径有问题。

– 由于高负荷，摄像机可能无法正常工作。断开访问摄像机的其他网络设备或降
低摄像机的比特率分辨率。

– 确保网络路径中的路由器、交换机或网线没有问题。
如果圆圈为灰色，表示流超过了本产品的标示性能。

– 降低摄像机的分辨率和/或比特率。

• 确保产品或摄像机没有重复的 IP 址（请参照4.6 检查是否有重复的 IP 地址
[} 48]）。

• 确保输入的摄像机用户具有管理权限。

• 检查摄像机流传输设定是否正确（请参照 2.2 设定摄像头 [} 15]）。

• 如果协议为“ONVIF”、“AXIS”或“Panasonic/i-PRO”，且传输模式为
“Unicast”，则选择“RTP over RTSP”作为连接方法。由于 TCP 用于流传
输，因此问题可以通过数据包控制来解决。

• 检查使用的交换机和网络电缆是否适合处理传输的信息量。如果传输模式为单
播，则传输的信息量为（摄像机比特率）x（连接数）。

• 选择“Troubleshooting”>“Network Connection Status”，然后检查当前
的通信带宽（发送、接收）。
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4.4 其他问题
4.4.1 无法登录

• 重新输入用户名和密码。

• 使用重置按钮重置账户信息，并以默认设定账户身份登录（请参照1.2 控制和功
能 [} 10]）。

4.4.2 无法显示设定屏幕
• 必须以用户级别为“ADMIN”的用户身份登录。

• 需要 USB 鼠标才能进行设定。无法使用遥控器进行设定。

4.4.3 设定的日期和时间显示不正确
• 如果系统在一周或更长时间内未连接到电源，则日期和时间将无法正确显示。在

这种情况下，请再次设定日期和时间（请参照2.7 设定日期和时间 [} 26]）。

4.4.4 无法在浏览器中查看 Web 控制台
• 确保产品没有重复的 IP 地址（请参照4.6 检查是否有重复的 IP 地址 [} 48]）。

• 检查计算机的 IP 地址是否正确（请参照4.7 检查计算机的 IP 地址 [} 48]）。

4.4.5 许可证注册失败
• 确保系统已设定为正确的日期和时间（请参照2.7 设定日期和时间 [} 26]）。

• 请将错误代码、产品名称、序列号、产品软件版本和错误的许可证文件发送给您
的许可证经销商。

4.4.6 鼠标/键盘不起作用
• 正确连接 USB 线缆。

• 拔出 USB 线缆并重新连接。

• 确保未启用 USB 锁定功能（有关详细信息，请参照《用户手册》）。

4.4.7 摄像机显示位置无法更改
• “CAMERA CONTROL”或“ADMIN”用户可以操作摄像机（有关详细信息，

请参照《用户手册》）。

• 摄像机的显示位置在顺序显示期间无法更改（有关详细信息，请参照《用户手
册》）。
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4.4.8 无音频输出
• 检查立体声微型插孔电缆连接是否正确。

• 输出设备的音量是否设定为“0”？

• 检查摄像机的设定。

– 音频输入是否正确配置？

– 是否启用了音频流传输？

– 您是否选择了本产品支持的音频压缩格式？

4.5 使用 Ping 检查摄像机连接
要执行 Ping，请执行以下操作之一。

• 在“Camera Registration”编辑屏幕中单击“Ping”。

• 选择“Troubleshooting”>“Connection Confirmation”，然后选择摄像机
并单击“ping”>“Run”。

如果无法连接摄像机，将显示“Destination Host Unreachable”。确保摄像机已
开机，并且网络路径中的路由器、交换机和网线没有问题。

• 示例）执行结果

– 如果可以连接摄像机
PING 192.168.0.27 (192.168.0.27) 56(84) bytes of data.
64 bytes from 192.168.0.27: icmp_seq=1 ttl=64 time=0.741 ms
64 bytes from 192.168.0.27: icmp_seq=2 ttl=64 time=0.771 ms
64 bytes from 192.168.0.27: icmp_seq=3 ttl=64 time=0.797 ms

– 如果无法连接摄像机
PING 192.168.0.27 (192.168.0.27) 56(84) bytes of data.
From 192.168.0.150 icmp_seq=1 Destination Host Unreachable
From 192.168.0.150 icmp_seq=2 Destination Host Unreachable
From 192.168.0.150 icmp_seq=3 Destination Host Unreachable
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4.6 检查是否有重复的 IP 地址
a. 选择“Troubleshooting”>“Network Connection Status”，然后单击
“Current Status”。如果本产品的 IP 地址与其他设备重复，则将显示“Unicast
reply from”指明重复单元的编号。设定唯一的 IP 地址。

• 示例）执行结果

– 如果没有重复的 IP 地址
ARPING 192.168.0.150 from 0.0.0.0 eth0
Sent 2 probes (2 broadcast(s))
Received 0 response(s)

– 如果有重复的 IP 地址
ARPING 192.168.0.150 from 0.0.0.0 eth0 
Unicast reply from 192.168.0.150 [00:00:00:00:00:00] *1 
Sent 2 probes (2 broadcast(s)) 
Received 0 response(s)

*1 显示重复设备的 MAC 地址。

4.7 检查计算机的 IP 地址
对于 Windows 计算机，您可以按照以下步骤检查和更改 LAN 端口网络设定。

1. 按 Windows + R 键。

2. 在“运行”窗口中输入 ncpa.cpl，然后单击“确认”。

3. 从列表中选择“以太网”，然后双击。
如果有多个 LAN 端口，则显示“以太网 2”和“以太网 3”。

4. 选择“互联网协议版本 4 (TCP/IPv4)”，然后单击“属性”。

5. 更改网络设定，然后单击“确认”。

有关设定的详细信息，请联系计算机制造商。
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附录

关于电器电子产品有害物质限制使用标识

本标识根据岁电器电子产品有害物质限制使用管理办法岁，适用于在中华人民共和国
销售的电器电子产品岁标识中央的数字为环保使用期限的年数岁只要您遵守该产品相
关的安全及使用注意事项岁，在自制造日起算的年限内岁，不会产生对环境污染或人
体及财产的影响岁上述标识粘贴在机器背面岁下表是依据SJ/T 11364-2014的规定编
制。

产品中有害物质的名称及含量

部件名称 有害物质

铅（Pb） 汞（Hg） 镉（Cd） 六价铬
（Cr（VI））

多溴联苯
（PBB）

多溴二苯醚
（PBDE）

印刷电路板 ╳ 〇 〇 〇 〇 〇

机箱 〇 〇 〇 〇 〇 〇

其他 ╳ 〇 〇 〇 〇 〇

本表格依据SJ/T 11364的规定编制。

〇：表示该有害物质在该部件所有均质材料中的含量均在GB/T 26572规定的限量要求以
下。
╳：表示该有害物质至少在该部件的某一均质材料中的含量超出GB/T 26572规定的限量要
求。

有限保修
EIZO Corporation（以下简称“EIZO”）和EIZO授权的经销商（以下简称“经销
商”），接受并依照本有限保修证书（以下简称“保证书”）之条款，向从EIZO或
经销商购买本文中所规定产品（以下简称“产品”）的原买方（以下称“原买方”）
提供保证：在保证期内（规定如下），如果原买方发现按本产品使用说明书（以下简
称《用户手册》）所述方式正常使用本产品过程中，本产品出现故障或损坏，EIZO
和经销商根据其独自地判断免费修理或更换该产品。

本保证期限定为自本产品购买之日起的二（2）年期间（以下简称“保证期限”）。
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EIZO和经销商将不向原买方或任何第三方承担本保证书所规定之外的与本产品有关
的任何责任或义务。

本产品停产七（7）年后，EIZO及经销商不再保留或保存产品的任何零件（设计零件
除外）。

维修产品时，EIZO与经销商将使用符合我方质量控制标准的替换零件。若由于自身
条件或缺少相关零件而不能修理设备，EIZO和经销商可提供性能相同的更换产品，
而无需维修。

本保证书仅对于设有经销商的国家或地区有效。本保证书并不限定原买方的任何法律
权利。

无论本保证书的任何其他条款如何规定，对于任何下列情况之一，EIZO和经销商将
不承担本保证书规定责任：

1. 由于运输损害、改装、改动、滥用、误用、意外事故、错误安装、灾害、附着灰
尘、维护不善和/或由除EIZO和经销商以外的第三方进行不适当的修理造成本产
品的任何故障。

2. 由于可能发生的技术变更和/或调整造成本产品的任何不兼容性。

3. 传感器的任何老化，包括传感器的测量值。

4. 因外设设备造成本产品的任何故障。

5. 因在除EIZO和经销商估计以外的环境条件下使用而造成本产品的任何故障。

6. 产品附件的任何老化（如缆线、《用户手册》、CD-ROM等）。

7. 消耗品及/或产品附件的任何老化（如电池、遥控器、触控笔等）。

8. 本产品表面的任何变形、变色和/或翘曲。

9. 将产品放置在可能受强烈振动或冲击影响的位置，可能会导致产品出现缺陷。

10. 因附着灰尘造成冷却风扇的任何老化或故障。

为了获得本保证书规定的服务，原买方必须使用原包装或其他具有同等保护程度的适
当包装将本产品运送到当地的经销商，并且预付运费，承担运输中的损坏和/或损失
的风险。要求提供本保证书规定的服务时，原买方必须提交购买本产品和标明此购买
日期的证明。

按本保证书规定进行了更换和/或修理的任何产品的保证期限，将在原保证期限结束
时终止。

在返回给EIZO和经销商进行修理后，任何产品的任何媒体或任何部件中储存的数据
或其他信息发生任何损坏或损失，对此EIZO和经销商将不承担责任。

对于本产品及其质量、性能、可销售性以及对于特殊用途的适合性等，EIZO和经销
商不提供其他任何明示或暗示的保证。

因使用本产品或无法使用本产品或因与本产品有任何关系（无论是否根据合同）而造
成：任何附带的、间接的、特殊的、随之发生的或其他的损害（包括但不仅限于：利
润损失、业务中断、业务信息丢失或其他任何金钱损失）以及侵权行为、过失、严格
赔偿责任或其他责任，即使已经向EIZO和经销商提出了发生这些损害的可能性，对
此EIZO和经销商概不承担责任。

本免责条款还包括因第三方向原买方提出索赔而可能发生的任何责任。本条款的本质
是限定由于本有限保修证书和 / 或销售本产品所发生的EIZO和经销商的潜在责任。
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